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1	Introduction
This document is a template for Word (doc) versions. If you are reading a paper version of this document, so you can use it to prepare your manuscript. When you open template.doc, select “Page Layout” from the “View” menu in the menu bar (View | Page Layout), which allows you to see the footnotes. Then type over sections of template.doc or cut and paste from another document and then use mark up styles. The pull-down style menu is at the left of the Formatting Toolbar at the top of your Word window (for example, the style at this point in the document is “Text”). Highlight a section that you want to designate with a certain style, then select the appropriate name on the style menu. The style will adjust your fonts and line spacing. Do not change the font sizes or line spacing to squeeze more text into a limited number of pages. To insert images in Word, position the cursor at the insertion point and either use Insert | Picture | From File or copy the image to the Windows clipboard and then Edit | Paste Special | Picture (with “Float over text” unchecked). ADMT will do the final formatting of your paper. 
2	Procedure for Paper Submission
All manuscripts are to be submitted online at http://admt.iaumajlesi.ac.ir/. Select “Submit Manuscript,” then click “Register.” Once you enter your e-mail address, you will receive an e-mail message containing your tracking number and password. This information will allow you to track your manuscript’s status, update submission data, upload your manuscript and subsequent revisions, and communicate with the editors, through your Author Status Page, at anytime during the publication process. After entering all required submission data, you must use the “Upload Manuscript” feature of the Author Status Page to upload your submission. Remember that your document must be double spaced before you upload it. Please be sure the name of the file you upload for processing is short and simple (i.e., “msc12345.doc”) with no spaces, tildes, symbols, or other unusual characters. Authors are encouraged to upload PDF and doc files. Failure to meet these requirements could result in a processing error that would require you to re-upload your manuscript. Once you have uploaded your manuscript, please inspect the file for accuracy. This step is required to complete your submission. If you experience difficulties with the upload and/or conversion of your manuscript, please submit your manuscript electronically for review as e-mail attachments. (jmechanic@iaumajlesi.ac.ir or journalmechanic@gmail.com)
3	Equations, Numbers, Symbols, and Abbreviations
Equations are centred and numbered consecutively, with equation numbers in parentheses flush right, as in Eq. (1). Insert a blank line on either side of the equation. First use the equation editor to create the equation. If you are using Microsoft Word, use either the Microsoft Equation Editor or the Math Type add-on (http://www.mathtype.com) for equations in your paper, use the function (Insert>Object>Create New>Microsoft Equation or Math Type Equation) to insert it into the document. Please note that “Float over text” should not be selected. To insert the equation into the document, do the following:
1. Select the “Equation” style from the pull-down formatting menu and hit “tab” once.
2. Insert the equation, hit “tab” again,
3. Enter the equation number in parentheses.
	A sample equation is included here, formatted using the preceding instructions. To make your equation more compact, you can use the solid us (/) or appropriate exponents when the expression is five or fewer characters. Use parentheses to avoid ambiguities in denominators.

	(1)
Be sure that the symbols in your equation are defined before the equation appears, or immediately following. Italicize symbols (T might refer to temperature, but T is the unit tesla). Refer to “Eq. (1),” not “(1)” or “equation (1)” except at the beginning of a sentence: “Equation (1) is…” Equations can be labeled other than “Eq.” should they represent inequalities, matrices, or boundary conditions. If what is represented is really more than one equation, the abbreviation “Eqs.” can be used. Define abbreviations and acronyms the first time they are used in the main text. Very common abbreviations such as SI, ac, and dc do not have to be defined. Abbreviations that incorporate periods should not have spaces: write “P.R.,” not “P. R.” Delete periods between initials if the abbreviation has three or more initials; e.g., U.N. but ESA. Do not use abbreviations in the title unless they are unavoidable.
4	General Grammar and Preferred Usage
Use only one space after periods or colons. Hyphenate complex modifiers: “zero-field-cooled magnetization.” Avoid dangling participles, such as, “Using Eq. (1), the potential was calculated.” [It is not clear who or what used Eq. (1).] Write instead “The potential was calculated using Eq. (1),” or “Using Eq. (1), we calculated the potential.”Use a zero before decimal points: “0.25,” not “.25.” Use “cm2,” not “cc.” Indicate sample dimensions as “0.1 cm  0.2 cm,” not “0.1 x 0.2 cm2.” The preferred abbreviation for “seconds” is “s,” not “sec.” Do not mix complete spellings and abbreviations of units: use “Wb/m2” or “webers per square meter,” not “webers/m2.” When expressing a range of values, write “7–9,” not “7~9.”A parenthetical statement at the end of a sentence is punctuated outside of the closing parenthesis (like this). (A parenthetical sentence is punctuated within parenthesis.) In American English, periods and commas are placed within quotation marks, like “this period.” Other punctuation is “outside”! Avoid contractions; for example, write “do not” instead of “don’t.” The serial comma is preferred: “A, B, and C” instead of “A, B and C.” If you wish, you may write in the first person singular or plural and use the active voice (“I observed that…” or “We observed that…” instead of “It was observed that…”). Remember to check spelling. If your native language is not English, please ask a native English-speaking colleague to proofread your paper. The word “data” is plural, not singular (i.e., “data are,” not “data is”). The subscript for the permeability of vacuum µ0 is zero, not a lowercase letter “o.” The term for residual magnetization is “remanence”; the adjective is “remanent”; do not write “remnance” or “remnant.” The word “micrometer” is preferred over “micron” when spelling out this unit of measure. A graph within a graph is an “inset,” not an “insert.” The word “alternatively” is preferred to the word “alternately” (unless you really mean something that alternates). Use the word “whereas” instead of “while” (unless you are referring to simultaneous events). Do not use the word “essentially” to mean “approximately” or “effectively.” Do not use the word “issue” as a euphemism for “problem.” When compositions are not specified, separate chemical symbols by en-dashes; for example, “NiMn” indicates the intermetallic compound Ni0.5Mn0.5 whereas “Ni–Mn” indicates an alloy of some composition NixMn1-x. Be aware of the different meanings of the homophones “affect” (usually a verb) and “effect” (usually a noun), “complement” and “compliment,” “discreet” and “discrete,” “principal” (e.g., “principal investigator”) and “principle” (e.g., “principle of measurement”). Do not confuse “imply” and “infer.”Prefixes such as “non,” “sub,” “micro,” “multi,” and “"ultra” are not independent words; they should be joined to the words they modify, usually without a hyphen. There is no period after the “et” in the abbreviation “et al.” The abbreviation “i.e.,” means “that is,” and the abbreviation “e.g.,” means “for example” (these abbreviations are not italicized).
5	Units
Use either SI (MKS) or CGS as primary units. (SI units are strongly encouraged.) English units may be used as secondary units (in parentheses). This applies to papers in data storage. For example, write “15 Gb/cm2 (100 Gb/in2).” An exception is when English units are used as identifiers in trade, such as “3½ in disk drive.” Avoid combining SI and CGS units, such as current in amperes and magnetic field in oersteds. This often leads to confusion because equations do not balance dimensionally. If you must use mixed units, clearly state the units for each quantity in an equation. The SI unit for magnetic field strength H is A/m. However, if you wish to use units of T, either refers to magnetic flux density B or magnetic field strength symbolized as µ0H. Use the center dot to separate compound units, e.g., “A·m2.”
6	Figures, Tables, and Other Images
Insert tables and figures within your document either scattered throughout the text or all together at the end of the file. Use the Table drop-down menu to create your tables; do not insert your figures in text boxes. Figures should have no background, borders, or outlines. In the electronic template, use the “Figure” style from the pull-down formatting menu to type caption text. You may also insert the caption by going to the Insert menu and choosing Caption. Make sure the label is “Fig.,” and type your caption text in the box provided. Captions are bold with a single tab (no hyphen or other character) between the figure number and figure description. See the Table 1 example for table style and column alignment. If you wish to centre tables that do not fill the width of the page, simply highlight and “grab” the entire table to move it into proper position.

	Table 1 Transitions selected for thermometry

	
	Frequency, cm-1
	FJ, cm-1
	G, cm-1

	0
	44069.416
	73.58
	948.66

	1
	42229.348
	73.41
	2824.76

	2
	40562.179
	71.37
	4672.68

	0
	42516.527
	1045.85
	948.76



[image: ]
Fig. 1	Mapping nonlinear data to a higher dimensional feature space.

Place figure captions below all figures. If your figure has multiple parts, include the labels “a),” “b),” etc., below and to the left of each part, above the figure caption. Please verify that the figures and tables you mention in the text actually exist. When citing a figure in the text, use the abbreviation “Fig.” except at the beginning of a sentence. Do not abbreviate “Table.” Number each different type of illustration (i.e., figures, tables, images) sequentially with relation to other illustrations of the same type. Figure axis labels are often a source of confusion. Use words rather than symbols wherever possible. As in the Fig. 1 example in this document, write the quantity “Magnetization” rather than just “M.” Do not enclose units in parentheses, but rather separate them from the preceding text by commas. Do not label axes only with units. As in Fig. 1, for example, write “Magnetization, A/m” or “Magnetization, Am1,” not just “A/m.” Do not label axes with a ratio of quantities and units. For example, write “Temperature, K,” not “Temperature/K.” Multipliers can be especially confusing. Write “Magnetization, kA/m” or “Magnetization, 103A/m.” Do not write “Magnetization (A/m)  1000” because the reader would not then know whether the top axis label in Fig. 1 meant 16000 A/m or 0.016 A/m. Figure labels must be legible (approximately 8–12 point type).
7	Conclusion
Although a conclusion may review the main points of the paper, it must not replicate the abstract. A conclusion might elaborate on the importance of the work or suggest applications and extensions. Do not cite references in the conclusion as all points should have been made in the body of the paper. Note that the conclusion section is the last section of the paper to be numbered. The appendix (if present), acknowledgment, and references are listed without numbers.
8	Appendix or Nomenclature
Appendix or nomenclature, if needed, appears before the acknowledgements.
Acknowledgments
The preferred spelling of the word “acknowledgment” in American English is without the “e” after the “g.” Avoid expressions such as “One of us (S.B.A.) would like to thank…” Instead, write “F. A. Author thanks…” Sponsor and financial support acknowledgments are also to be listed in the “acknowledgments” section.
References
Number citations consecutively in square brackets [1]. The sentence punctuation follows the brackets [2]. Multiple references [2, 3] are each numbered with separate brackets [1]–[3]. When citing a section in a book, please give the relevant page numbers [2]. In sentences, refer simply to the reference number, as in [3]. Do not use “Ref. [3]” or “reference [3]” except at the beginning of a sentence: “Reference [3] shows ....” Please note that the references at the end of this document are in the preferred referencing style. All references should be in 9-point font, with reference numbers inserted in superscript immediately before the corresponding reference. You are not required to indicate the type of reference; different types are shown here for illustrative purposes only.
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All of the preceding information is required. The journal issue number (“No. 11” in Ref. 1) is preferred, but the month (Nov.) can be substituted if the issue number is not available. Use the complete date for daily and weekly publications. Transactions follow the same style as other journals; if punctuation is necessary, use a colon to separate the transactions title from the journal title.
Books and Book Chapters
[3] Author 1, A., Author 2, B., Book Title, 3rd ed, Publisher, Publisher Location, Country, Year, pp. 154–196, ISBN.
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[9] Morris, J. D., Convective Heat Transfer in Radially Rotating Ducts, Proceedings of the Annual Heat Transfer Conference, edited by B. Corbell, Vol. 1, Inst. of Mechanical Engineering, New York, 1992, pp. 227–234.
Reports, Theses, and Individual Papers
[10] Chapman, G. T., and Tobak, M., Nonlinear Problems in Flight Dynamics, NASA TM-85940, 1984.
[11] Steger, J. L., Jr., Nietubicz, C. J., and Heavey, J. E., A General Curvilinear Grid Generation Program for Projectile Configurations, U.S. Army Ballistic Research Lab., Rept. ARBRL-MR03142, Aberdeen Proving Ground, MD, Oct. 1981.
[12] Tseng, K., Nonlinear Green’s Function Method for Transonic Potential Flow, Ph.D. Dissertation, Aeronautics and Astronautics Dept., Boston Univ., Cambridge, MA, 1983.
Electronic Publications
CD-ROM publications and regularly issued, dated electronic journals are permitted as references. Archived data sets also may be referenced as long as the material is openly accessible and the repository is committed to archiving the data indefinitely. References to electronic data available only from personal Web sites or commercial, academic, or government ones where there is no commitment to archiving the data are not permitted in the reference list. 

[13] Richard, J. C., and Fralick, G. C., Use of Drag Probe in Supersonic Flow, AIAA Meeting Papers on Disc [CD-ROM], Vol. 1, No. 2, AIAA, Reston, VA, 1996.
[14] Atkins, C. P., and Scantelbury, J. D., The Activity Coefficient of Sodium Chloride in a Simulated Pore Solution Environment, Journal of Corrosion Science and Engineering [online journal], Vol. 1, No. 1, Paper 2, URL: http://www.cp/umist.ac.uk/JCSE/vol1/vol1.html [cited 13 April 1998].
[15] Vickers, A., “10-110 mm/hr Hypodermic Gravity Design A, Rainfall Simulation Database [online database], URL: http://www.geog.le.ac.uk/bgrg/lab.htm [cited 15 March 1998].
Always include the citation date for online references. Break Web site addresses after punctuation, and do not hyphenate at line breaks.
Computer Software
[16] TAPP, Thermochemical and Physical Properties, Software Package, Ver. 1.0, E. S. Microware, Hamilton, OH, 1992.
Include a version number and the company name and location of software packages.
Patents
Patents appear infrequently. Be sure to include the patent number and date.
[17] Scherrer, R., Overholster, D., and Watson, K., Lockheed Corp., Burbank, CA, U.S. Patent Application for a “Vehicle,” Docket No. P-01-1532, filed 11 Feb. 1979.
Private Communications and Web Sites
References to private communications and personal Web site addresses are not permitted. Private communications can be defined as privately held unpublished letters or notes or conversations between an author and one or more individuals. Depending on the circumstances, private communications and Web site addresses may be incorporated into the main text of a manuscript or may appear in footnotes.
Unpublished Papers and Books
Unpublished works can be used as references as long as they are being considered for publication or can be located by the reader (such as papers that are part of an archival collection). If a journal paper or a book is being considered for publications choose the format that reflects the status of the work (depending upon whether it has been accepted for publication):
[18] Doe, J., Title of Paper, Name of Journal (to be published).
[19] Doe, J., Title of Chapter, Name of Book, edited by Publisher’s name and location (to be published).
[20] Doe, J., Title of Work, Name of Archive, Univ. (or organization) Name, City, State, Year (unpublished).

Unpublished works in an archive must include the name of the archive and the name and location of the university or other organization where the archive is held. Also include any cataloging information that may be provided. Always query for an update if a work is about to be published.
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